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Data Transfer Overview

« Uses the System i5 database server to transfer data to and from DB2
database files and System i5 source physical files

* Provides SQL-like interface to allow full file SELECT or customized
gueries including joins, sorting, and record grouping

« Capable of transferring data to and from many popular PC file types
* Provides access to System i5 file members
» Transfers may be run

— Interactively

— In batch mode

— Programmatically
— Directly from Microsoft Excel
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Data Transfer Overview

Data Transfer is limited to transferring source physical files and data physical
files to PC file types and PC file types to the source and data physical files on the
System i5. Transferring other types of files to and from a PC and the System i5
requires using other methods. Some other types of files that reside on the
System i5 are stream files or flat files such as those stored in the Root or
NetWare portions of the System i5 Integrated File System. These files may be
accessed using the methods listed below.

System i5 NetServer through 'shares'

ISeries Navigator Integrated File System (IFS) support
File Transfer Protocol (FTP)

The IBM Toolbox for Java IFS classes

ISeries Access for Web
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Components of a Data Transfer

Supported transfer request file types

« Data Transfer From iSeries
Dats Transfer — .DTF - New request type used in iSeries Access
- — .TTO - Request type used in XD1 and DOS Extended clients
— .DT - Request type used in Windows 3.1 client
— .RTO - Rumba transfer request file
B « Data Transfer To iSeries
- DaTta_;r;_n';fer — .DTT - New request type used in iSeries Access
sover — .TFR - Request type used in XD1 and DOS Extended clients
— .DT - Request type used in Windows 3.1 client
— .RTO - Rumba transfer request file
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Data Transfer Usage

« Basic Data Transfer

 Running Data Transfer by Clicking an lIcon
e Scheduling Data Transfers

« Using the Excel Add-in

e Using Data Transfer with a Web server

e Using the Data Transfer Query Builder
 Tips and Tricks with Data Transfer
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Basic Data Transfer

Upload file to System i5
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Basic Data Transfer

What is the iSeries Database File Wizard?

e The wizard creates a:
— File Description File (FDF)
— Database file on the server
* The wizard does not do the actual data transfer to the System i5
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Basic Data Transfer

Starting the iSeries Database File Wizard

8 Data Tran-fer To iSeries !EI E
File Wiew Toal elp

S = ‘

~FC

File name: I_

Create i5eries Database File |

Start the Create
iISeries Database
File tool by
selecting it from the
Tools menu or by
clicking on its icon
in the toolbar

Welcome
—i5enes
Systen: I

Library/File[k ember

Thiz wizard allows you to create an iSenes databaze
file from an existing P file.

Yau will be required to zpecify the name of the PC
file from which the iSenes file will be bazed, the
name of the iSeriesz file which to create, and zeveral
other neceszary details.

< Back

Cancel | Help |
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Basic Data Transfer

Selecting the PC File and the File Type

Create i9eries Database File Ed |

PC File Mame

“What iz the name of the PC file which containzg paur
data’?

Create i%eries Database File E3 |

File Type

What iz pour PC file tppe?

Browze. .. |

File type:

< Back Hest » Cancel Help

< Back Hest » Cancel Help
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Basic Data Transfer

The File Description File and Create iSeries Database File panels
Create iseries Databasefle M|

Create File Description File

What iz the name of the file dezcription file pou Create iSeries Database File Ed |

would like to create?

Change Data Farmat Options

Eile narme:

Ta properly create an iSeries databasze file, the carect
format of your data must be provided.

C:hbemph.diransferscustomer. FOF Browse...

Options such az date format and decimal separataor
muzt be set o match pour data.

[f theze optionz are not changed, default values are
uzed. Thiz could rezult in data corruption or Failure
when trangfeming data to the new databasze file.

To zet the proper format options far pour data, press
Format Options.

< Back Mext » Cancel Help

Eormat Options. .. |

« Back Mext » Cancel | Help |
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Basic Data Transfer

The Scan PC File panel
Create iseries Databasefle M|

Scan PC File

Tao create an Series databaze file the PC file

must be zzanned to determine ite data layout, Create iSeries Database File B |

Select Start Scan to beqgin the zcan.

Contents of FC File

Below iz a list of fieldz which the zcan operation
determined the PC file contained. Theze field
definitionz will be uzed to create the iSeres File.

| Start Scan Field | Type | Length| =
CUSHUM MUMERIC E
e o j LETHAR CHARACTER a8
¥ First rowe of data contains field names INIT CHARACTER 5 |
STREET CHARACTER 13
CITY CHARACTER E
STATE CHARACTER 2 _ILI
¢ Back Mest » Canel Help ‘| | »

Details. . |

< Back Hest » Cancel | Help |
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Basic Data Transfer

The Field Details panel

Field Details EH |
Mame: ILSTNK-‘«M
Dezcription: I
— Attributes
Tvpe: |CHARACTER =]
Length: g 3: Allocate: a 3:
Siale: 0 3: Padding: 0 3:
CCSID: I“DEF.E-.LILT
Defaul;  ['DEFAULT
ull capable
[~ Mul capabl

W Include in file description file

k. Cancel Help
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Basic Data Transfer

The System Name panel

Create iSeries Database File E3 |

System Mame

| !
YWhere should your databasze file be created? Create iSeries Database File =] |

ISENEs SEMVET

MY S S TEM -]

iSeries File and Library

Wrhat iz the name of the file which will contain
pour data? Far example, TESTLIBATESTFILE.

The file you specify muzt not already exist in the
zpecified libramy and pou must have authority to
write ko the library.

Library/Eile:

MFO/CUSTOMER Browsze. .. |

¢ Back Mest » Cancel Help

< Back Heut » Cancel Help
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Basic Data Transfer

The File Description Text panel
Create iSeries Databasefile M|

File Description Test

You can aszociate a line of text with the file which

describes the contents of the file. Create iSeries Database File X] |

File text: Confirm Create Options

IS eres server:

MYSYSTEM

My customer information

Library/File:
IMFO/CUSTOMER

PLC file description file:

C:Mtemphdiransfercustomer FDF

Select Mest to create the iSenes databaze file and

< Back et > Lancel Help Ve 2L [l sl Tk

< Back Hest » Cancel Help
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Basic Data Transfer

The final panel - your file has been created!

Create iSeries Database File [ x| |

Caongratulationsz!

'ou have successfully created an iSenes database
fil.

Jze Data Transfer ToiSenes to transfer data from
your PC file ta the new database file.

Prezz Finish to return bo Data Transfer To iSenes.

Cancel Help

< Back

| want an . © 2007 IBM Corporation



IBM System i

Basic Data Transfer

Returning to Data Transfer To iSeries

The PC file we used as a
model

i Data Transfer To iSeries !E[ E |

File Miew Toaols Help

PN
The SyStem we Created the File name: II::"«temp'\dtransfer'ﬁcustumer.'I23 Erowse... |
flle upon —iSernes
System:  [MYSYSTEM =]

Libran/File(t ember);

|INFIII£I:LISTIIIMEFE Browse...
The Library/File name of Dietis..
our new file J—
& Tranzfer data to iSeries >
||
Click to transfer data to /
your new file
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Basic Data Transfer

Key points about the iSeries Database File Wizard

 Creating the table and FDF does not do the data transfer

* Plan ahead by increasing lengths if necessary
* Do not include character and numeric data in the same column
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Basic Data Transfer

Data Transfer to iSeries: Specifying iSeries File Details

i Data Transfer To iSeries !E[ E |

File Miew Toaols Help

’igﬁﬂ||%

—PC
File name: II::"«temp"u:ltransfer'\custumer.'I 23 Browse. .. |
—iSernes
Sustem: IM‘T’S‘T’STEM j
Libran/File(t ember);
IINFDHELISTEIMEFE Browse...
Dretails. ..

Tranzfer data ta iSeries
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Basic Data Transfer

Data Transfer to iSeries: iSeries File Details - upload options

iseriesFilepetails —_____________________HEH|
Source Physical files | [ —
« Select not to use an FDF file File name: [C-\temp'divansfertcustomer FOF Browse. |
e Select the proper file type Aol [5Ci Ten =
« Select the record length, file Translate from:  [5C1 F| wwEseor
and member text and authority Coged heracter5eiD; |
on Create —iSernies file
Create iSeries object |No. replace member only |
' : femnber bt |
Data PhySICaI fIIeS [Series file hpe: % [Data £ Source
eUse a PC FDF file Field reference file name: | Browse... |
« Select Field Reference File, file e bt T
and member text, and authority Authorty [Feadronte ]
when creating new files Fils et |
oK Cancel | Help
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Data Transfer Usage

e Basic Data Transfer

 Running Data Transfer by Clicking an Icon
e Scheduling Data Transfers

« Using the Excel Add-in

e Using Data Transfer with a Web server

e Using the Data Transfer Query Builder

 Tips and Tricks with Data Transfer
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Running Data Transfer by Clicking an Icon

Saving the request

8 Data Transfer To iSeries !EI E |

File Wiew Toaols Help

’igﬁn||%

Clicking File->Save As allows
you to save the request.

—PC

File namme; II:: wemphdiransfersoustomer. 123 Browsze. . |
—iSernes

Systerm: IM‘T’S‘T’STEM j

Library/File[k ember):
|INFI:IHELISTEIMEF| Browse. ..

Details...

Tranzfer data ta iSeries
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Running Data Transfer by Clicking an Icon

Auto-run/Auto-close support

Properties : d B

Clicking File->Properties allows Conversions | Library List | Display | SAL | Connection Startup

you to customize properties Riequest options

related to this data transfer. V¥ Run transfer request automatically
v Close on completion

OK Cancel Apply Help
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Running Data Transfer by Clicking an Icon

Running by double-clicking the ico

& dtransfer =]

File Edit ‘“iew Favorites Tools  Help |i

{=Back = = - | 00 search 02 Folders @l

n

x>

Address |73 C:\tempidtransfer j Pao
T FOF
ZI =

custamer, 123 customer. FOF  [yyeEdulii= =

dtt

Type: Data Transf 474 bytes |@l My Comnpuker

Transfer to i5eries Complete

Tranzfer statistics:

Rows transfered:

12

© 2007 IBM Corporation
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Running Data Transfer by Clicking an Icon

Batch transfer command interface

« RTOPCB

— Does batch data transfers from System i5 to PC
 RFROMPCB

— Does batch data transfers from PC to System i5
* RXFERPCB

— Does batch data transfers from System i5 to PC
— Does batch data transfers from PC to System i5
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Running Data Transfer by Clicking an Icon

Data Transfer from iSeries: Batch transfer command interface

RTOPCB [/S] [[/1] [filename [/C] [...]]| [[1] /F list file] ]

IS Show transfer statistics.
flename An iSeries to PC transfer request (.TTO or .DTF),
Rumba (.RTO), or Windows 3.1 (.DT) file transfer

request.
IC Process next file independent of previous file.
/ lgnore warnings.
IF Process files within list file (one filename per line).

list file A file containing a list of transfer files to process.

Examples:
RTOPCB c:\temp\test.tto
RTOPCB /S c:\temp\test.tto /C c:\temp\trans.dtf
RTOPCB /S /F c:\temp\transfer.dtf
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Running Data Transfer by Clicking an Icon

Data Transfer to iSeries: Batch transfer command interface

RFROMPCB [/S] [[/1] [filename [/C] [...]11| [/1] [/F list file] ]

IS Show transfer statistics.
flename A PC to iSeries file transfer request (.TFR or .DTT),
Rumba (.RTO), or Windows 3.1 (.DT) file transfer request.

IC Process next file independent of previous
file.
IF Process files within list file (one filename per line).

list file A file containing a list of transfer files to process.

Examples:
RFROMPCB c:\temp\test.tfr
RFROMPCB /S c:\temp\test.tfr /C c:\temp\trans.dtt
RFROMPCB /S /F c:\temp\transfer.dtt
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Running Data Transfer by Clicking an Icon

Data Transfer between iSeries: Batch transfer command interface

RXFERPCB request userlD password

request - Fully qualified file name of any Client Access upload or download
request of type .DTF, .DTT, .TTO, or .TFR.
useriD - A valid iSeries user profile for the system specified in the request.

password - A valid password for the specified user profile.

Examples:
RXFERPCB c:\temp\upload.dtf myuserid mypassword
RXFERPCB c:\temp\download.dtt myuserid mypassword
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Running Data Transfer by Clicking an Icon

Shortcut to the Data Transfer command line interface

Update Customers Properties E E |

General  Shartcut | Dpti-:nn&l Foart I Lay-:nutl I:l:nll:ursl Se-:urit_l,ll

To create a new shortcut:

= Right click on an open area of Windows ﬁ pdate Customers
Explorer (or My Computer)
=» Select New -> Shortcut

T arget bwpe; Application

T arget location: Client Access

» F|nd and SeIeCt the RXFERPCB, RTOPCB, Target: Program Filesh BMAClient Accesshrfrompob, exe”
or RFROMPCB program in the Client Access
Folder ¥ Funin separate memory space. [ Bun as differant user

=» Name the shortcut
=» Right click on the new shortcut and select
properties from the menu

Start in; I"E: “Program Filesh BMY\Client Acceszs"

Shartcut key: INu:lne

= Add the full path of the transfer request to run e
after the command Comment |
= Select to run minimized Fod Taget. | Changeloon. |

k. Cancel | Apply
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Running Data Transfer by Clicking an Icon

Running by double-clicking the icon

& dtransfer =]

File Edit “iew Favorites Tools  Help |i

(= Back » = - | & search 04 Folders @l »
Address | ©:\templdtransfer lff'}GD

Bt ﬁ,

custamer, 123 customer . FOF  mycustome. .. Update
iCustomers;

|4 object{s) |E-.85 KE |@l My Computer A
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Data Transfer Usage

e Basic Data Transfer

 Running Data Transfer by Clicking an lIcon
* Scheduling Data Transfers

« Using the Excel Add-in

e Using Data Transfer with a Web server

e Using the Data Transfer Query Builder
 Tips and Tricks with Data Transfer

| want an . © 2007 IBM Corporation



IBM System i

Scheduling Data Transfers

Add a scheduled task

* iSeries Access for Windows Scheduled TaskWizard [
does not pI‘OVIde a Scheduler ;I'Dhlizﬂlsel;}.ulijzr?;j helpz you gchedule a task for Windows
program. For this example, we
use Microsoft's Task Scheduler
application.

* To access Microsoft’'s Task
Scheduler, go to your Control
Panel, select Scheduled Tasks,
and select Add Scheduled Task.

au zelect the pragram pou want Windows ba i,
and then schedule it for a convenient time.

Click Mext to continue.

< Back
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Scheduling Data Transfers

Add the transfer request to run Update Customersaty K|

Taszk |5|:hedule| SEttingsl Securit_l,ll

. MOdlfy the Run line to include the E CoWINNTAT asksbUpdate Customers Daily.job
transfer you want to run

Bun: I:cess'\rfmmpch.e:-:e” "Crustemphdtransfersmycustamers. dit

Browsze. . |

Start i I"I::‘-.F'rl:ngram FileshBMAClient Acoess”
LComments: |
Fiuh as: Im}'USEfid Set password...

[+ Enabled [scheduled tazk runs at specified time)

k. Carncel Apply
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Scheduling Data Transfers

Viewing scheduled tasks

E=1 Scheduled Tasks _ O]

File Edit ‘jew Favorites Tools Advanced Help

S Back v = - | @Search L Falders @ | [ R X v | Ed-~

Address I Scheduled Tasks j @ Go |
m Mare ¢ I Schedule I Mext Run Time I Lask Run Time I Skatus

q
j Add Scheduled Task,
ki

LI|:u:|aI:e Cuskomers Daily Ak 3:00 aAM every d...  S:00:00 &M ... Mever
Scheduled Tasks

This folder contains tasks you've
scheduled For Windows, Windows
automatically performs each task at
the scheduled kme,

Faor example, wou can schedule a time
For Windows ko clean up wour hard disk,
by deleting unnecessary files.

Select an item to view ks descripkion,

| |

|2 object(s) |
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Data Transfer Usage

e Basic Data Transfer

 Running Data Transfer by Clicking an lIcon
e Scheduling Data Transfers

e Using the Excel Add-in

e Using Data Transfer with a Web server

e Using the Data Transfer Query Builder
 Tips and Tricks with Data Transfer
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Using the Excel Add-in

Data Transfer from iSeries

Library: QIWS
Table: QCUSTCDT

J File Edit “ew Insert Format Tools Data Window Help =171 x|
DR ERY sEC » - &= As8%H BA4D 203
| aria -0 - BIUSE=E %, WA E DAY
Al ~] =
[ 0 K |t [ | N [ 0o [ P | @ 7
1 o
2
3
4
g
5]
7
g
g
10
11
12
13
14
4 [» [ M Sheet1 { shestz £ sheets /
Ready | | | |

© 2007 IBM Corporation
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Using the Excel Add-in

What is the Excel Add-in? _
Bl

» Available with Microsoft Excel 97, Excel 2000, and Excel XP.

 Use this support by:
— Clicking on the Data Transfer upload or download button on the Excel toolbar
— Using the options on the Data menu bar
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Using the Excel Add-In

Installing the Excel Add-In

* Open Microsoft Excel

£ Microsoft Excel - Book1 M=l B3
® CIle Add-lns from the J File Edit View Insert Fgrmatlﬁgata Wwindow Help ;|i|5||
Tools menu DEESRY $a¥sin. 7 Lz idlil e -0,
- | il o0 o | B g, Wm0 A 2
* Click the Browse... TR chare Workbock..
button 1 A B | C Track Changes b | F | G | H | | E
. . . Merge Workbooks,
* Locate the path in which |2 Protection .
you InSta”ed Cllent 1 Cnline Collaboration
]
Access a i
* Double click on the ] \ Audiing .
folder named 'Shared' | Macre .
e DOUbIe CIle On the ]1 ustornize, ..
. M 4[» [m]\Sheet1 ; sheetz / she épti:ns 4]
cwbtfxla file Readly St T T

* Click the OK button
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Using the Excel Add-in

Data Transfer from iSeries: The Transfer Request panel

Ed Microsoft Excel - Book1 =]
J File Edit Wiew Insert Format Tools Data Window Help -|E|5|
IDEeE RY sB2RY v - @@= 8 msD 20A

B 7 U S

B % % ,

.0 .00

I g}_v 3

J Arial mlic B . il >
A | =|
0k LM [N 0 I
L |
2
3 Transfer Request EH |
4 — Transfer Bequest
g ¥ Lreate new
7 = Create from file [*.d, = tho, =.dt, %to]
g I Browze, .
=)
10
11 — Starting cell pozition
12
13 LColurnm: I & Bow: I 1
14
I44» ¢\ Sheetl i Sheetz f Sheet3 / W Include column headings
Ready |
ak. Cancel | Help |
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Using the Excel Add-In

Data Transfer from iSeries: Creating a new data transfer request

Data Transfer from iSeries |

Syztem Mame

YWhere iz your data located?

ISENEs sEMver:

¢ Back Mest » Cancel Help
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Using the Excel Add-In

Data Transfer from iSeries: Choose the file to download

Data Transfer from iSeries

iSeriez File and Libraryp

What library and file(z) containg pour data? For
example, QMWS/ACUSTCDT or
QWS AACUSTCOT. TESTLIBATESTFILE.

You can browse for available librariez and files
by preszing the brawse buttan.  Typing in the
library name and preszing browse will browse
the available files in that libran.

Libran/Eile[k embier];

QIWSAACUSTCDT Browsze... |

< Back Mext » Cancel Help
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Using the Excel Add-In

Data Transfer from iSeries: Customize the Data Transfer request

Data Transfer from iSeries E3 |

Cusztomize File Transfer

'ou can customize how pour data iz trangferred. By
default, all your data will be tranzfered.

To zelect which data you want o transfer, press Data
Optionz.

Drata Options. ..

To change how paur data iz farmatted, press Farmat
O ptions.

Eaormat Optians. ..

To change run-time options, presz Properties.

Properties. ..

< Back Cancel Help
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Using the Excel Add-In

Data Transfer from iSeries: Customizing Data Options

« Customizing Data Options allows you
to set options like:

— what fields are retrieved
— the ordering of the data

— only retrieve data based on certain
conditions

| want an . © 2007 IBM Corporation
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[T Enable group functions

Ok

Cancel
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[
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Using the Excel Add-In

Data Transfer from iSeries: Customizing Format Options

Change Format Options
Date/Time |Decimals| Misc I
—Date

D ate format;

D ate zeparator: I[“'l] Slash j Change Format Options

DratedTime DECima|3|Misc I

— Time
Time format: I[HMS] Hours Minutes Secands W dgnore emors
. Change Format Options E E |
Time zeparatar: I[:] Calan .
- Decimal separatar D atedTime | Decimals  Mizc |
Decimal zeparatar: I[,] Periad [ —Soart
. Carcel | Spply F Sort sequence: iSeries Default
Tiable: |
— Language
QK Cancel Aoply H Language: I iSenes Job Default j
Language [0 I
Ok Cancel | Spply | Help
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Using the Excel Add-In

Data Transfer from iSeries: Customizing run-time options

» Conversions

— Allows for the enablement of special
data conversions and for error logging
— Diata converzion

e LI brary List ™ Convert CC5ID 65535
. [ Log position of untranslatable fields
[ J
DISpIay ™ Ereserve tabs
- SOL

» Connection

— Can configure signon and security
options
e Startup

— Can enable option to run transfer oK Ciee Apply Help
request automatically later

properties " E|

Conversians |Li|:|rar_l,I Listl Displa_l,ll sOL I Ennnectinnl Startupl
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Using the Excel Add-In

Data Transfer from iSeries: Specify a file name

Data Transfer from iSeries E3 |

Save request to file

Y'au can zpecify a file name ta stare your request
irformation.

If pou zave your request toa fhle, you can i the
request again without having to recanfigure pour
options.

If you chooze not to zave the information to a file,
the infarmation will only be used far the duration of
this request.

File narne:

C:Mtemphdiransferscustomerdat a. dif

< Back Finizh Cancel Helm
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Using the Excel Add-In

Data Transfer from iSeries: Viewing the results

Fd Microsoft Excel - Book1 M=] B3
J File Edit Miew Insert Format Tools Data Window Help ;lilil
DEEHERY s2ad o - @z &84 @aw -0 08
| aria -0 - |B 7 U SE=EE|8%, @8 EE DA
Al hd =
A B [ ¢ | o | E | F | & | H [ 1 [ 4 | kK |=

1 |CUSMLUM _LSTN;&M IMIT STREET (CITY STATE  ZIFCOD COTLMT CHGCOD |BALDUE COTDUE | =

2 938472 Henning G K 4359 Elm 4 Dallas TH 7a217 5000 3 a7 a

3 339283 Jones BD 218 N 1. Clay MY 13041 400 1 1a0 a

i 392859 Vine 55 PO Box 75 Broton WT od4G 700 1 439 a

5 935435 Johnson  J A 3 Alpine YW Helen G, Joa45 9999 2 J957 .5 J3.5

B 397267 Tyron W E 13 Myrtle [Hector MY 14541 1000 1 I I

7 3859572 Stevens KL 208 Snow Derver Co o225 400 1 68.75 1.5

a3 346283 Alison J5 787 Lake [Isle hil a5342 5000 3 10 a

5 475933 Doe W 29 Archer | Sutter CA, 85585 700 2 250 100

10|  BY382Y Thomas AN 3 Dove CinCasper WY 52R04 EIE e 2 o o

11 093029 Williams ED 435 5E 2 +Dallas TH 75218 200 1 25 a

12 192837 Les FL 0963 Dak Hector MY 14541 700 2 439 .5 0.5

13 083990 Abrabam M T 392 il Stlsle b 6342 9999 3 aa0 a

14
[4 |4 » [#],Sheetl ; Sheetz f Sheet3 / | «| |
Ready | | | [ [ _
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Using the Excel Add-In

Data Transfer to iSeries: Notes

« Support for uploading data added in V5R1

« Support allows the following functions for transferring data to the iSeries:
— Create new file and member based on iSeries file
— Create new file and member based on spreadsheet
— Create new member
— Replace member
— Append to existing member
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Using the Excel Add-in

Data Transfer to iSeries: Highlighting the data

Fd Microsoft Excel - Book1
J File Edit Yew Insert Format Tools Daka Window Help == %]
DEE SRY | BB~ - &= 4L @S -3, [HI
| aria -0 - B I USE=EE 8%, BB EE DA
Al | =| CUSNUN
A
1 JCUSNHUM
2 | 938472
3| 839263
4| 392859
5 | 538485
6| 397267
7 | 389572
8 | 845283
9 | 475938
10| 693529
11| 593029
12| 152837
13| 553960
14
4|4 [p M\ Sheetl / Sheet2 £ Sheet3 / | 4]
Ready | Bum=793ig4szs | [ [ [ |
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Data Transfer Usage

e Basic Data Transfer

 Running Data Transfer by Clicking an lIcon
e Scheduling Data Transfers

« Using the Excel Add-in

* Using Data Transfer with a Web server
e Using the Data Transfer Query Builder
 Tips and Tricks with Data Transfer
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Using Data Transfer with a Web server

HTML File support - Updating a web server on System i5

Data Transfer to

Workstation T
1 X b HTML File
—— Generated
< 2 e at PC

Send HTML to System i5
Web Server (file system)

Client browser
views HTML on
System i5 Web

Server
v

it

Client PC
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Using Data Transfer with a Web server

HTML File support - Updating a web server on another machine

Data Transfer to

Workstation
X x HTML File
—— Generated
- at PC

Send HTML to
Web server

Client browser
views HTML on
Web Server

it

Client PC

AlIX or NT Web
Server
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Running Data Transfer by Clicking an Icon

Incoming Remote Command (IRC)

* Installable option of iSeries Access
« Gives System i5 users ability to start remote commands on a PC

* Message logged in the iSeries Access for Windows History log identifying
what was run

« CWBRXD
— Name of program that controls Incoming Remote Commands

— Runs as a Windows service called iSeries Access for Windows Remote
Command.

* RUNRMTCMD

— System i5 server CL command
— Used to send PC command requests to the PC running the IRC service.
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Using Data Transfer with a Web server

Downloading a file to HTML

2 Data Transfer From iSeries

File Wiew Help

S E

—i5enes

System name:

File narme:

MYSTSTEM |
QlwS/ACUSTCDT =] Browse..
Drata Options. ..

~PC

File name:

Output device:

I HyperT ext Markup Language [HTHL]

j Details.

II:: remphdtransfermpdata. him

Browsze...

Faormat Options. ..

Tranzfer data from S enes
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Using Data Transfer with a Web server

Setting HTML properties

* File HMiDetals KM
° Document File |Dn:n::ument| Table I Eaptinnl Fiow I Cell I Templatel
. . . ™ ilse auto sizing
— Specify a title and timestamp imtmng T2 <B
e Table ¥ Prompt before ovenwrite
. . . — Translation and charset
— Specify spacing, alignment, and other table o eEDCG NS
roperties £ ASCl
p ] p “ LUTF-3
e Capthn Charset: wiridows-1252
— Specify whether to add a caption for your
table
e Row
e Ce” ] Canicel Spply Help
* Template
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Using Data Transfer with a Web server

HTML Template support - enhancing web pages

HTML Template allows System 15
tabular data to be inserted into a pre-
formatted HTML document at a
specified location. The location is

defined by an embedded template
tag.

The template document may contain
graphics, links, frames, and any other
HTML elements you provide.

persls U EE|

File | Dn:u:umentl T ahle I Eaptinnl R | Cell

[V Usze HTML template file

Template file:

Template |

II::"-.template. hitrnl Browsze. . |

Embedded template tag:
|<!-- TABLET --»

Cancel Apply

Help
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Using Data Transfer with a Web server

Using HTML Template Files

<HTML>

<HEAD>

<TITLE>Sample HTML Code</TITLE>
</HEAD>

<BODY>

<H1>Customer Data</H1>

<l-- TABLE1 -->

</BODY>

</HTML>

When the transfer is run, the template file will be used as a base for the new HTML file.
When data is received from the System i5, the data will be formatted and will inserted in
place of the <!-- TABLEL --> tag.
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Using Data Transfer with a Web server

DATALINK data type support

Transferring the DB2 UDB for iSeries DATALINK type to a HTML file will produce
active links within your HTML File.

CUSTNAM ADDRESS PHONE WEBSITE
Bob Rochester, MN 800-426-3333 http://www.ibm.com/eserver/iseries/index.html
John Anaheim, CA 800-270-8223

http://www.common.org/index.html
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Using Data Transfer with a Web server

Viewing the results

3 RCOHASDEE - QIWS,/QCUSTCDT - Microsoft Internet Explorer
File Edt View Favorites Tools Help |-
Address [@] C:\templdtransferymydata.htm ~| 6o
CUSNUM LSTNAM INIT STREET| CITY [STATE ZIPCOD CDTLMT CI
038472 |Hemning |GK [15°°  |Dallas TX (75217 5000 |3
Elm Ave
839283 Jones BD ﬂg”gf‘f Clay NY 13041 400 1
302850  Vine S S 1_;90 Box |proton VT 046 700 1
938485 |Johnson JA fW‘:;P‘“E Helen GA 30545 9999 2
13
397267 Tyron  WE Myrtle Hector NY 14841 1000 1
Dr
t[l rn r [I [ lﬂ:l
&) bone LT S My Computer /
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Using Data Transfer with a Web server

Movement of data

« Data Transfer may be used as an data utility in e-business processes.

— May be used to upload gathered transactions to the System i5 from a PC
server acting as the e-business interface.

— May be used by CGI programs on the PC Server to build standard PC files
which may then be sent to customers through the web.

— May be used to generate HTML files to be published on a web server.

— ActiveX objects (or RXFERPCB) may be used in 3-tier to run data transfer
from a Windows Web Server.
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Data Transfer Usage

e Basic Data Transfer

 Running Data Transfer by Clicking an lIcon
e Scheduling Data Transfers

« Using the Excel Add-in

e Using Data Transfer with a Web server

« Using the Data Transfer Query Builder
 Tips and Tricks with Data Transfer
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Using the Data Transfer Query Builder

Starting the Data Transfer query builder

2% pata Transfer From iSeries

File iew Help

2 |

—iSeriez
Syztem name: IMYS‘T’STEM j

File narme: :I Browsze... |
[~

—PC
Output device: I Digplay j Details...
File manme: | Browsze,..

Farmat Dptions. ..

Tranzfer data fromm S eries
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Using the Data Transfer Query Builder

Setting up a query

Change Data Options EH |
ity by

Enter "SQL-like"

statements directly ——
into the edit panels 3
Select:

O R where:

H awitim:

Click on Details... to Order by:

bring up the Data
Transfer query builder Betum records with mizsing fields
[T Enable groop :

k. Cancel Detailz. .. Help

S ) L D I e i ) e [
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Using the Data Transfer Query Builder

Select fields to transfer from the iSeries

Double click on field
names in the field list
to add them to the
Select clause.

Functions such as
SUM may also be
used to return
functional results

| want an . © 2007 IBM Corporation

ReceeRequestvetals K]
Select |Where| Order B_I,II
— Select
Field | D ezcription | Type | Lengthl Digitl [ =
CUSHLIM CUSTOME... Z0OMED G G
» | LSTHAK LAST Mak...  CHAR 8 1]
INIT FIRST aMD... CHAR 3 0 —
STREET STREET A.. CHAR 13 1]
CITY CITY FIELD CHAR E 1]
STATE STATE ABB... CHAR 2 0 -
1| | »
Eunction:
AV -
COUNT
b
kIMN
ClIkd j

Select clause:

ok,

Cancel Apply | Help
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Using the Data Transfer Query Builder

Creating a where clause

Receive Request Details ﬂ E |
Specify conditions on data Select Where | Order By |
transferred from the System i5 by “here
building a where clause. Field [ Desciption | Type | Length| _ Digit] [
CLISMLIR CUSTOME... Z0OMED B B
LSTHAR LAST MAK... CHAR a ]
Double click on a field name or STREET  STREETA.  CHAR 50
2 c c CIT CITY FIELD: CHAR B 1]
specify a function, then specify a STATE STATE ABB.. CHAR 2 0
test condition by double clicking on l | >
. Hat: Function: Testk: Others:
atest operator. Ent_er thg right — = i’ T B—
side of the comparison in the CURAENT - OR
comparison dialog. il bl =
Wwihere clause:
[LSTHAM = Henning') ]
=
Ok Cancel Apply | Help
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Using the Data Transfer Query Builder

Ordering data

Receive Request Details ﬂ E |
An Order By clause may be Select | Where Dicer B |
specified to order data transferred - Order by
from the SyStem |5 Field | Description | Type | Length| Digit] [
CUSNUM CUSTOME.. ZOMED 3 3
LSTHAM LAST NAM... CHAR 3 0
: . INIT FIRST AND... CHAR 3 0 =
Fields may be ordered in STREET STREETA..  CHAR 13 0
: . oY CITYFELD  CHAR G 0
ascending or descending order by STATE STATE ABB.. CHAR 2 0 =
specifying either ASC or DESC J ' ‘
Function: Others:

after each field name. Currently,

. : AN A |1 2]
on the System i5, fields used in the v :| her
order by must also exist in the N [ =

Select clause.

Order by clauze:
CUSHUM DESC =]

Ok Cancel Apply | Help
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Using the Data Transfer Query Builder

Multi-file joins

When multiple files are specified
for download on the main Data
Transfer panel, a join clause may
be built to conditionally join
records across multiple files.

| want an . © 2007 IBM Corporation

Receve Requestvetals |
Selectl Wherel Order By  Join By |
—Join by
Fizld | Dl ezcription | Type | Lengthl Digitl [:l
T1.COTDUE CREDIT DU... Z0OMED B B
T2 CUSHLUM LOMG 4 g
T2 LSTHAR CHAR a 1]
TZINIT CHAR 3 0 J
T2S5TREET CHaR 13 1]
T2CITY CHAR B o -
4| | 3
Test: Others:
¢ [ AMD
=
i
Jain by clauze:
T1.CUSHUM = T2 CUSHLM ;I
Cancel Apply | Help
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Using the Data Transfer Query Builder

Record grouping

Receive Requestdetals —_______HH|
If Group By functions are enabled on Select | Where | Having| Order By Group By |
the Data Options panel_, a Group By _ Group By
Statement may be SpeCIerd to group Fizld | Dl ezcription | Type | Lengthl Digitl [~
CUSHLIM CUSTOME... ZOMED B B
records that are returned. carh CLoTOME- ZDME °
[MIT FIRST AWND...  CHAR 3 0 —
STREET STREET &.. CHAR 13 1]
CIT%" FIELD CHaR B 1]
STATE STATE ABB... CHAR 2 o -
1| | Ll_l
Group by:
aTY =
[
] Cancel Apply | Help
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Using the Data Transfer Query Builder

Conditional grouping using Having

Receive Request Details K |
Conditional record grouping from a Select | Where Having | Order By | Group By
Group By operation may be done by re
p = . I Hat: Function: Testk: Function: Others:
SpeCIfylng a HaVIng clause. MOT e £ L congtant: AMD
= A oR
el <l £ COUNT
MIN I e
SlM b kAIM
»= SUM

Having clause:

[COUNT[ = 1] =]

Cancel Apply | Help
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Using the Data Transfer Query Builder

Activating the Native SQL Interface

2" Data Transfer From iSeries [_ |C]] |

A Native SQL interface is = "~ properties KIS
provided for power users or
for situations where the

Ennversinnsl Library Listl Display  SOL |D:unnen:ti-:un| Startupl I

~iSenes— —SOL options ]
Da.ta TranSfel’ fOI’mat dOES 2ystemn " Process SELECT as Data Transfer format
not prOVIde enough File name % Process SELECT as native SOL J
functionality
— PE_ —
Dutput de J
File name J

. [ — k. Carncel Apply | Help

I'ransher daka from 2 enes I
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Using the Data Transfer Query Builder

Finding the Native SQL Interface

2" pata Transfer From iSeries

After choosing to process Fie View Help
your statement as Native A
SQL, the Data Options e
button activates a Native Sstemname:  [MYSYSTEM ]
SQL panel File name: |I:1IWS£EJELISTEDT ~|  Browse..
\ ll
[rata Optionz. ..
~PC
Output desvice: I Dizplay j Details...
File manme: | Browse,..
Farmat Options. ..
Tranzfer data from iSeries
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Using the Data Transfer Query Builder

Using the Native SQL Interface

£ Data Transfer From iSeries |

The Native SQL File Wiew Help Change S0L Select Options HE
s = 2] SOL Select statement: =
Interface aIIOWS you to hiibl < E | CELECT = FROM QWS AQCUSTCODT ﬂ

type in a free form
SELECT statement. A
list of files and columns
In those files are
provided to help you

—i5enes

System name

Filz name: _,I

Columnz in file(z]:

1 Field | Drezcription | Type | Lengthl -
bu”d your Statement CSMUM CUSTOME... Z0MED B
~FC LSTHAM LAST MAk...  CHaR g
: IMIT FIRST aMD... CHAR 3
Dutputdevict | STREET STREET A.. CHAR 13
CITY CITY FIELD CHAR B -
File rarme: 1 | 1
Library/File[kd br]:
QPwSAACUSTCDT
] Canicel Help
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Data Transfer Usage

e Basic Data Transfer

 Running Data Transfer by Clicking an lIcon
e Scheduling Data Transfers

« Using the Excel Add-in

e Using Data Transfer with a Web server

e Using the Data Transfer Query Builder

* Tips and Tricks with Data Transfer
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Tips and Tricks with Data Transfer

Setting up the library list

£/! Data Transfer From iSeries g Cl
File View Help

=

i ?
—iSenes s b D.ﬁ

System name: MYSYSTEM| Conversions  Librany List | Displa:.rl saL I Connection I Startup |

File name: These libraries are tempaorarly added to the iSeres job librany
list while this data transfer request is used.

iSeries library: |@|ws
{* Beginning ¢ End

—FC Library Mame: | Type ||~ Bemove |
Output device: IDi5p|a:,r QW3 zer
QTEMP System

Optional: To aid us
when we are looking
for files, we need to
add the libraries to
the library list.

To set properties go derene [ |abeveop Srem
to the File menu and QBLDSYSR Suen @]
select Properties.
Transf
i
QK Cancel Apphy Help
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Tips and Tricks with Data Transfer

Select desired signon mode

System i Navigator

Data Transfer
Right-click system, Properties

File menu -> Properties

2 M Rchasra2 Properties (2JEd

Properties

i . i ) - Administration System | Directory Services I Service I Plug-ins I
Conversions I Library List I D15p|EI‘_|'I SaL Connection | Startup I General Connection | Secure Sockets | Licenses I Restart
—iSeries signon information [P R i
™ Use Windows user name and password, no prompting
Ilze iSeres Mavigator setting j ﬁ
— mneisan
Use iSeres Navigator seft i i
lze Windows user name and password E @ Use defauit user 1D, prompt as needed
N |Use Kerberos principal. no prompting | |M\’NAME
SPEC sk M " Prompt every time
— Security
" Use Kerb indi 2 i
" Do not use Secure Sockets Layen(S5L) = Kerheras priwipet reme, ne promp g
Time-out for signon;
™ Use Secure Sockets Layer (S5L) m seconds (1-3600)

¥ Lse iSeres Navigator setting

~Performance

Cument setting: Do not use 550

IP address lookup frequency: IP address:

| Always | l's . 5 .24 117

¥ Enable data compression
Where to lookup remote port:

Database: I’SYS BAS
ISErver ;I

Mote: These values are used as defaults by other applications connecting from this PC

[ ok | cancel | opy Help R

oK | Cancel |  Hep |
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Tips and Tricks with Data Transfer

cwbtfdft.exe and cwbtfr.ini

e cwbtfdft.exe

— Located in your .. \IBM\Client Access directory

— Example usage:
cwbtfdft /dftchar:0

 cwhbtfr.ini options:

— Described at:
http://www-1.ibm.com/support/docview.wss?uid=nas1352f81ff9d0d4c86862565c2007cae44

— Example File:

[Client Access Data Transfer]
TabsAreTabs=1;

ForceTranslation=1
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Tips and Tricks with Data Transfer

f—

[ INFO.REFUNDS - Avtech.sho... ‘; Hé‘ﬁ

File Edit Yiew Rows Help

DATE
2005-02-23
2004-01-02

2004-02-21
2005-12-22
2004-10-17
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Tips and Tricks with Data Transfer
SQL Tips

* Renaming a column — Ex: COL1 AS CUSTOMERS
* Reordering columns

« CAST’Ing a column — Ex: CAST (COL1 AS INT)

« Scalar functions
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Tips and Tricks with Data Transfer

Common Problems

* Transfers to PC
— Working with CCSID 65535 fields
— Working with date/time/timestamp fields
— Modifying output into PC Files

» Transfers to Server
— V5R3 Data Transfer change to Unicode fields when uploading data
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Tips and Tricks with Data Transfer

Performance Considerations

« Data Compression
* Indexes

* SQL performance clauses
— OPTIMIZE FOR N ROWS
— FOR FETCH ONLY / FOR UPDATE
— FETCH FIRST N ROWS ONLY
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Tips and Tricks with Data Transfer

Hooking into ActiveX support

Add reference to cwbx.dll

In Visual Studio 2003, go to:
Project menu ->

Add Reference ... ->

COM tab ->

IBM AS/400 iSeries Access for
Windows ActiveX Object Library

Gorngos s

NET COM | Projects |

Compaonent Name

| 1... | Path

[l

HTML Inline Multimedia

TAS Core Components 1.0

IAS DataStore2 1.0

IAS Metwork Access Paolicy 1.0

IAS 500 1.0 Type Library
IE!H,AFE!EE.S _Su_Eport 1.0 Type Library

1.0
10
1.0
1.0
1.0
14

C:\Program Files\Microsoft Office. ..
CAWINDOWS \system 3 2Yassves. dll
CAWINDOWS \system32Yasads.dl 2
CAWINDOWS \system32Yasnap. dil
CAWINDOWS \system 3 2Yassdo. dll
C:\WINDOWS \systern32\TbmEga. ..
Droaram Eise TR Cliert Arce

iSeries Access for Wind.,, 11 ¢

iz

IEM DB2 UDFs for OLE DB

10

‘rogram Files\IEM Chent Acc
C:\PROGRA~1BMISQLLIB funct. .

IBM iSeries Access Programmer's To... 6.0  C:\Program Files\IBM\Client Acce. ..
IBMMenu 1,0 Type Library 1.0 CWINDOWS\system32\BMMen, .,
ierjplug 1.0 Type Library 1.0 C:'\Program Files\Real\RealPlayer...
iernnlun 1.0 Tvne |ihrary 1.0 C\Prooram FilesiReal\RealPlaver. .. M
Selected Components:
Component Name | Type | Source |

ok Cancel

Select

X
Browse... |
e

Remove |

Help
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Tips and Tricks with Data Transfer

Microsoft Visual Basic - Code

Dim dIr As New cwbx.DatabaseDownloadRequest
Dim mySystem As New cwbx.AS400System

mySystem.Define “MySystemName"
mySystem.UserID = “MyUserID"
mySystem.Password = “MyPassword"

Set dIr.System = mySystem

dir. AS400File = “QIWS/QCUSTCDT"
dir.pcFile = "c:\mycustomers.xIs"
dir.pcFile.FileType = cwbdtBIFF8

dir.Download
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Tips and Tricks with Data Transfer

Microsoft Visual Studio 2003 - C# Code

cwbx.DatabaseDownloadRequest myrequest = new cwbx.DatabaseDownloadRequestClass();
cwbx.AS400System mySystem = new cwbx.AS400SystemClass();

mySystem.Define( “MySystemName" );
mySystem.UserID = “MyUserID";
mySystem.Password = “MyPassword";

myrequest.system = mySystem;

myrequest.AS400File.Name = "QIWS/QCUSTCDT";
myrequest.pcFile.Name = "C:\\mycustomers.xIs";
myrequest.pcFile.FileType = cwbx.cwbdtFileTypeEnum.cwbdtBIFFS;

myrequest.Download();
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Tips and Tricks with Data Transfer
Recent Enhancements

* V5R4
— MS Excel XML Spreadsheet format
— 128 byte column names
— Can access data in an independent auxiliary storage pool (IASP)
— Supports creating and overwriting empty query result sets
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Summary

« Take advantage of all the ways you can use Data Transfer
— Running requests by clicking an icon
— Scheduling data transfers
— Using the Excel Add-in
— Using with a web server
— Running advanced queries
— Using ActiveX Automation Objects
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Session title: iSeries Access Data Transfer —
Tips and Techniques

Session ID: 409159

Agenda Key: 54CB

Speakers: Carole Miner
Ruben Ibarra Gonzalez
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System | Access for Windows sessions:

21CA 420017 System i Access for Windows: What's New in V5R4

22CA 409159 System i Access for Windows Data Transfer: Tips &
Techniques

26CC 403971 System i Access for Windows: Security &
Communications Tips

31CA 406172 PC5250 Emulation: Everything You Need To Know

32CA 401918 Performance Tune System i Access ODBC

33CA 420219 System i Access inthe .NET World

35LA/ 410160 OPEN LAB: System i Access for Windows with the

36LA Experts

52CB 402066 Administration of System i Access for Windows

System | Access for Linux session:
25CA 480144 Creating the System i Linux Desktop
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Appendices

« Components of a Data Transfer Notes

« Scheduling Data Transfers

« Administering Access to Data Transfer

« Data Transfer ActiveX Automation Objects
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Components of a Data Transfer

« Data Transfers involve 4 basic components
— PC File
— An iSeries Database or Source Physical File
— File Description File (FDF)
— New or existing transfer request
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Components of a Data Transfer

Component I: The PC File

* A PC file is a standard "flat file" located on (or to be created on) your
network or workstation.
« Data Transfer supports many popular PC file formats
— Lotus 1-2-3 (.123) and Lotus 1-2-3 version 4 (.wk4)
— ASCII Text (.txt)
— Basic Random and Basic Sequential
— Microsoft Excel (BIFF) versions 3, 4, 5, 7, and 8 (.xIs)
— Comma Separated Variable (.csv)
— Data Interchange Format (.dif)
— DOS Random, including type 2
— Tab Delimited Text (.txt)
— No Conversion (EBCDIC)
— Hypertext Markup Language (.htm, .ntml)
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Components of a Data Transfer:

PC File Types

Data Transfer supports many popular PC file formats when transferring data to or from the System i5.
However, some rules apply when performing a data transfer, especially uploading data to the System
i5.

Download
* The PC file type to download to must be able to hold the data from the System i5 file. For
example, downloading to a BIFF3 (Excel version 3) file limits character fields to 256 characters
and only allows 16,385 rows in a spreadsheet.

Upload
« |If uploading to an existing System i5 file, the format of the data in the PC file must match the
format of the data in the System i5 file.
« If the PC file has column names those names must match the names in the File Description File
and the System i5 file.
 The HTML file type is not supported for upload.
« Uploading to a database file (table) requires that you have a File Description File (FDF) to match
your PC file.
Uploading to a source physical file with a file type other than ASCII text will only send the first column
of data from the PC file. If more than one column exists in the PC file, you will get a message stating
that extra data was found at the end of the file and will be truncated.
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Components of a Data Transfer

Component Il: An iSeries Database or Source Physical File

Transferring data to or from the System i5 requires you to specify either a database table(s) or
source physical file. Each of these file types may contain multiple members.

Database File

An System i5 file in the form of a relational table. It has a specific layout composed of various
types of columns with various lengths.

Source Physical File
An System i5 file normally contains 3 columns. A SRCSEQ, SRCDAT, and SRCDTA column.
The first column is a sequence number. The second column is a date, and the last column

contains your data. The first two columns are six bytes each, and the last column may be
variable length.
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Components of a Data Transfer

Component Ill: The File Description File (FDF)

A file description file (FDF) is a PC file used to describe a PC data file. A file description file is
required when transferring data to a database file on the System i5.

An example file description file:
PCFDF

PCFT 19

PCFO1,1,1,1,1

PCFL Name 18

PCFL Address 1 13
PCFLZip26

PCFL Phone 1 8

PCFL Balance 2 8/2

| want an . © 2007 IBM Corporation



IBM System i

Components of a Data Transfer

File Description File (FDF)

The PC File Description File (FDF) contains various record types.
The first line of an FDF file must contain PCFDF. This line indicates that the file is an FDF.

The next line of the file, PCFT, indicates the PC file type. File type 19 signifies an FDF for use with the
Lotus 123 Version 9 file type. Values for other file types are as follows:

ASCIl Text = 1 Dos Random = 2 BasicSequential = 3 Basic Random =4
DIF=5 No Conversion = 6 Dos Random =7 Dos Random Type 2 =8
BIFF4=9 BIFF3 =10 BIFF5 =11 CSv=12

Lotus WK4 =13 Tab Delimited Text = 14 BIFF7 =15 BIFF8 = 16

Lotus 123 = 17 Excel Add-in =18 Lotus 123 Version 9 = 19

The PCFO line indicates PC file options. These options include date and time formatting and the
decimal separator to use.

The PCFL lines contain the fields of the PC file. These are in order, top to bottom, listing fields in the
PC file. The first column is the field name, for example, Address, the next column is the data type, and
the final column is the length. The most common data types are '1' for character and '2' for numeric.
TheI third column may contain two numbers separated by a '/'. This indicates that the field has numeric
scale.
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Components of a Data Transfer

Component IV: The Transfer request

 What is a transfer request?
— A transfer request is a PC file created by and used with Data Transfer for
storing options and settings for the transferring of data to or from the System
5.
« Some of the items stored in a transfer request include:
— System i5 system name
— System i5 file name(s)
— PC file name
— PC File Description File name
— PC file type
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Scheduling Data Transfers

Add a scheduled task

* iSeries Access for Windows Scheduled TaskWizard [
does not pI‘OVIde a Scheduler ;I'Dhlizﬂlsel;}.ulijzr?;j helpz you gchedule a task for Windows
program. For this example, we
use Microsoft's Task Scheduler
application.

* To access Microsoft’'s Task
Scheduler, go to your Control
Panel, select Scheduled Tasks,
and select Add Scheduled Task.

au zelect the pragram pou want Windows ba i,
and then schedule it for a convenient time.

Click Mext to continue.

< Back
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Scheduling Data Transfers

Choose the application to schedule

* Click Browse
* Choose the RXFERPCB.EXE,

Scheduled Task Wizard E3 |

Click the program pou want *indows b wn.
To zee more programs, click Browse,

RTO P C B . EX E O r Application | Yersiar |i|
[2] Acrobat Reader 4.0 4.05 —
R F RO M P C B . EX E p rog ram o8] Activei Contral Test Container  5.0.8063
(B &ddress Book E£.00.2800.11...

located by default in:
C:\Program Files\IBM\Client Access

%.ﬁ.ddress Book Paln Sync Install 1.0.0,5
.&ddres& Book Palm Sync Re..  4.78.0.25

ADSM Backup Client 3.1.0.1
L PN T=I VI o | R ll

« Back Hiewt = Canicel

| want an . © 2007 IBM Corporation



IBM System i

Scheduling Data Transfers

Choose how often to run the task

scheduled Task Wizard |

Type a name for thiz tagk. The tazk name can be
the zame name az the program name.

ILI pdate Cuztomers D aily

Ferfarm this task:

O WwWeekly

" Monthly

" Ore time anly

€ wihen my computer starts
 wihen | log on

< Back Mext » Cancel
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Scheduling Data Transfers

Choose the time to run the task

Scheduled Task Wizard |

Select the time and day pau want thiz tazk to start,
Stark tirme:
IETT=

Perfarm this tazk:

& Evem Day

 'wWeekdays

™ Every I'I _% days
Stark dake;

| 9/ 702003 =]

« Back
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Scheduling Data Transfers

Choose the user ID to run the task

Scheduled Task Wizard E3 |

Enter the name and pazsword of a uzer. The tazk will
fun az if it were started by that user.
Enter the uzer name: Imyu&erid
Enter the passwaord: | “““““
LCanfirm passwiond: I “““““
< Back Cancel |
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Scheduling Data Transfers

Verify summary information

Scheduled Task Wizard |

Y'ou have successfully scheduled the following task:
Ipdate Cuztormers D aily

Weindowes will perfarm this task:
AbB00 &AM every day, starting 9/7 /2003

‘Open advanced properties for thiz bask when | click
I Finish,

Click Finizh to add thiz tazk to pour %Windows schedule.

« Back Finizh Canicel
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Scheduling Data Transfers

Add the transfer request to run Update Customersaty K|

Taszk |5|:hedule| SEttingsl Securit_l,ll

. MOdlfy the Run line to include the E CoWINNTAT asksbUpdate Customers Daily.job
transfer you want to run

Bun: I:cess'\rfmmpch.e:-:e” "Crustemphdtransfersmycustamers. dit

Browsze. . |

Start i I"I::‘-.F'rl:ngram FileshBMAClient Acoess”
LComments: |
Fiuh as: Im}'USEfid Set password...

[+ Enabled [scheduled tazk runs at specified time)

k. Carncel Apply
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Scheduling Data Transfers

Viewing scheduled tasks

E=1 Scheduled Tasks _ O]

File Edit ‘jew Favorites Tools Advanced Help

S Back v = - | @Search L Falders @ | [ R X v | Ed-~

Address I Scheduled Tasks j @ Go |
m Mare ¢ I Schedule I Mext Run Time I Lask Run Time I Skatus

q
j Add Scheduled Task,
ki

LI|:u:|aI:e Cuskomers Daily Ak 3:00 aAM every d...  S:00:00 &M ... Mever
Scheduled Tasks

This folder contains tasks you've
scheduled For Windows, Windows
automatically performs each task at
the scheduled kme,

Faor example, wou can schedule a time
For Windows ko clean up wour hard disk,
by deleting unnecessary files.

Select an item to view ks descripkion,

| |

|2 object(s) |
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Administering Access to Data Transfer

¢ Some options include:
— Microsoft System Policy support
— Application Administration
— Exit Programs
— Object-level database security
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Administering Access to Data Transfer

g Microsoft System Policies
POLEDIT.EXE

« Data Transfer From iSeries - Limiting
downloads

— Prevent usage of Data Transfer From
iISeries

— Prevent usage of Data Transfer GUI

— Prevent usage of RTOPCB command

— Prevent autostart uploads

— Prevent usage of Excel-Add In

* Limiting users to only autostart

downloads will help to prevent them from
modifying transfer requests and keep

them from downloading any file they have
read access to on the System I5.

Foliciez |

£, Default User Properties [ 7] |

=1-AL) |EM iSeries Access Runtime Restictions

=-Ad) Data Transfer
=Ml Data Transfer Uploads
[ Prevent all Data Transfer o server
@ Data Trangter uploading options
=-Wdl Data Transfer Downloads
[ Prevent all Data Transfer from server
Elm Data Trangter downloading options

------ Prevent uzage of ETOPCE

----- Prevent autostart downloads
- Prevert Excel add-in downloads
EEI--@ Server file creation

EEI--@ Directory Update

b Prewvent Data Transfer GUI Downloads  —

[

ak.

Cancel
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Administering Access to Data Transfer

g Microsoft System Policies
POLEDIT.EXE

« Data Transfer To iSeries - Limiting

uploads

— Prevent usage of Data Transfer To
ISeries

— Prevent appending to/replacing host
files

— Prevent usage of Data Transfer GUI

— Prevent usage of RFROMPCB
command

— Prevent autostart uploads

 Limiting users to only autostart uploads
will help to prevent them from modifying
transfer requests and keep them from
using Data Transfer in potentially
harmful ways.
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Foliciez |

Etﬂl [BM i5enes Access Funtime R estrictions
=-0d Data Transfer

Eltﬂl Data Transfer Uploads

----- Frevent all Data Transfer to server

Eu:_fl Drata Transfer uploading options

----- Frevent Diata Transfer GUI Uploads
= Prevent uzage of RFROMPCE

------ Frevent autaztart uploads

- Prervent Excel add-in uploads
EIUE] Data Transfer Downloads

----- Frewvent all Data Transfer from sereer
@ Data Tranzfer downloading options
EEI--@ Server file creation

------ Prevent appending/replacing host files

=]

=]

0k

Cancel

#J, Default User Properties |
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Administering Access to Data Transfer

g Microsoft System Policies

[Everaut serproperties )
POLEDIT.EXE — |
° Da‘ta Tran Sfer TO ISerIeS - |Ser|es server EE&ME}S;!E;[::;:?S Runtime R estrictions ﬂ
fl Ie Creatl on [+ Data Transfer Uploads

@ Data Transfer Downloads
E||.ﬂ| Server file creation

- Preve nt Creatlon Of new fl IeS on the ----- Fresvent server file creation
. —|-ALJ] Filz creation options
SySte m |5 - '111' F'revtent sgrtver file creation based on PC fil

------ Frewvent server file creation based on existii_—

— Prevent creation of files via the Data

EEI--@ Directory Update
- @ Passwords
Tran Sfer EEI--@ iSeries Mavigator
: : : : - ica -
- Create iSeries Database File wizard | Er | y-

— Prevent creation of files via the standard

» "created based on" or Field Reference
File method.

ak. Cancel
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Administering Access to Data Transfer

Getting a system setup for policies

1. Get the System Policy Editor from http://www.microsoft.com.
2. Open an MS-DOS window.

3. Go to the iSeries Access for Windows directory, normally located at:
[C:]\Program Files\IBM\Client Access\

4. Run the cwbadgen /std command in the MS-DOS window. This
generates the caerestr.adm policy template needed to create the policy
file.

For more information on policy support see:
http://publib.boulder.ibm.com/infocenter/iseries/v5r4/index.jsp?topic=/rzaii/rzaiiconfiguration.htm
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Administering Access to Data Transfer

Getting a system setup for policies

Start the policy editor by double-clicking on poledit.exe.

Go to Options > Policy Template > Add.

Go to the location where you stored the .adm files that you created in creating
policy templates.

4. Select the .adm files that you want to add and press Add. Keep doing this until
you have added all the .adm files you want to use. Click OK.

Select File > New Policy.

Set your policies and save the policy file:
1. WQYOURSYS\POLICIES\config.pol (for Windows 95/98) -or-
2. \QYOURSYS\POLICIES\ntconfig.pol (for Windows NT)
7. Where:
*  QYOURSYS is the name of your System i5 NetServer.

Wn e

o U1

* POLICIES is the name of the shared file folder on your System i5 NetServer.

* (nt) config.pol is the name of your policies file.

* To update the policy file, open your policy file with the policy editor, make your changes and
save the file back to the above location.

* Note: You must create and maintain policies for the Windows 95/98/Me and Windows
NT/2000 separately. (Policies created for Windows 95 will not work on an NT system, and
vice-versa.)
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Administering Access to Data Transfer

ISeries Navigator Application Administration

° TO g et to Ap p I I Catl 0 n Application Administration {Local Settings) - Rchasdghb
. . . . Select the functions or applications available to uzers.
Administration: —
iSenies Mavigator  Client Applications | Host Applications I

- O pe ni Se rnes N avil g a-to r i Defaul Access Al Object Azcess | Customized Access | = |

. 62 1Senes Access for Windows _I
- CI |Ck on th e SySte m yOU splay and Printer Emulator
. . B~ Data Transfer
want to adm Inister EH206 Download from server
—2E GUI Downloads
_ i —EE se of RTOPCE
G O to the FI Ie m e n u T2 Autostart Downloads
I I —EA Ercel Add-in Downloads
an d Sel eCt Ap pl ICatI on —EE Activel Automation Downloads
-> g lpload to zerver
Administration -> Local 1 gooadiosene
1 —H® Appending or Replacing Host Files
Settlngs —H3 GUI Uploads
83 Use of RFROMPCE

@5 Autostart Uploads _ILI

4 F
Remove Customization | [Cuztamize |

Applications ... | ] I Cancel | Help |
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Administering Access to Data Transfer

ISeries Navigator Application Administration

* Application Administration
— Provides similar capabilities as Microsoft PC based policies
— Administration information is stored on the System i5
— Data Transfer options are stored on a per user/per System i5 basis
— Customize user access to Data Transfer functions
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Administering Access to Data Transfer

ISeries host server exit programs

« Exit Programs
— Exit programs written for the QIBM_QZDA NDB, ROI, and SQL exit points
may help to restrict certain users from accessing specific files.
— Configured with WRKREGINF on the System i5

— Given the SQL statement sent from the client application (Data Transfer).
Statements may be rejected by the user exit program

— May be written in a variety of host languages

Note: Data Transfer and ODBC use the same server for database access.

Currently, exit programs created for Data Transfer are also active for ODBC
users.
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Administering Access to Data Transfer

Object-level database security

 All objects on the server, including SQL objects, are managed by the
system security function

See:
http://publib.boulder.ibm.com/infocenter/iseries/vsrd/index.jsp?topic=/rzahf/rzahfsecurity.htm
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Data Transfer ActiveX Automation Objects

ActiveX? Automation Objects? So what's this? What can they do for me?

ActiveX Automations are re-usable objects that reside on your
Windows PC. Many times they can be used to run an application by
"remote" with a program or script.

They work similarly to Object Linking and Embedding (OLE), used
for things like inserting an Excel spreadsheet into a WordPad
document. Not just cutting and paste, actually "linking" the
spreadsheet into the document.

ActiveX objects work much like this, except in the programming world.
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Data Transfer ActiveX Automation Objects

So what can they do for me?

ActiveX automations can be used to quickly and easily perform many tasks
with little or no user intervention. For example, a program may use the
Automations for Microsoft Excel to perform various data calculations
without ever bringing up the Excel interface.

ActiveX automations can be used to create new custom interfaces
over applications that have ActiveX automations. A few examples are
Microsoft Office products, Internet Explorer, the PC5250 emulator, and
various iSeries Access for Windows functions.
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Data Transfer ActiveX Automation Objects

OK, how do | use them?

* ActiveX automations are supported by many programming languages
including:
— Visual Basic
— Visual Basic for Applications (used by Microsoft Office)
— Visual Basic Script (used in web pages and the PC5250 emulator)
— C++
— Java
— Lotus Script
— Many other applications and development environments

* You must write program code to use these objects. Or allow some
development tool to write the code for you.
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Data Transfer ActiveX Automation Objects

What Automations are available for Data Transfer?

* Two types of ActiveX Automations for Data Transfer
— High Level Automations
— Low Level Automations

» Labeled based on functionality and ease of use

| want an . © 2007 IBM Corporation



IBM System i

Data Transfer ActiveX Automation Objects

High Level Automations

Easier to use, but limited functionality!

With the high level automations you can run a Data Transfer with as little as 2 lines
of code!
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Data Transfer ActiveX Automation Objects

The High Level Automation Object
The name of this object is DatabaseTransfer

The DatabaseTransfer object can be used to run a simple upload, download,
or an existing transfer request file!
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Data Transfer ActiveX Automation Objects

Using the DatabaseTransfer Object

These two lines of Visual Basic (VB) code can be used to run a download:

Dim dt As New cwbx.DatabaseTransfer
dt.Download "mysys", "qgiws/qcustcdt”, "c:\myfile.xls", cwbdtBIFF5

To do an upload:

dt.Upload "mysys", "cwbxtest/qcustcdt”, "c:\qcustcdt.txt", "c:\gcustcdt.fdf"

To run a saved request:

dt.Transfer "c:\gcustlst.dtf"
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Data Transfer ActiveX Automation Objects

Using the DatabaseTransfer Object

The DatabaseTransfer automation object also contains properties
you can query or set for the transfer request.

* Errors - for query only. A standard collection of error messages.
Messages get put into this collection while the request is running

» Password - Allows you to set the password for the System i5
connection necessary for the transfer

* TransferResults - Allow you to get the number of rows transferred,
return codes, and error and warning locations.

» UserlD - Allows you to set the user ID to use for this transfer request.
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Data Transfer ActiveX Automation Objects

The Low Level Automation Objects

* There are two main Low Level Objects:
— DatabaseDownloadRequest
— DatabaseUploadRequest

 Various properties must be set on these objects to perform an upload
or download

« Used with other Client Access Express Automation objects.

| want an . © 2007 IBM Corporation



IBM System i

Data Transfer ActiveX Automation Objects

Using the DatabaseDownloadRequest Object

The DatabaseDownloadRequest object can be used to programmatically perform
a download from the System i5 to a PC workstation. It contains 5 additional

objects that may be set to perform a download. Each of these objects has various
settings.

DatabaseAS400File - Stores the name of the file or files to download.

o DatabaseDownloadPCFile - Stores the name of the PC file to download, plus
file options.

o DatabaseQuerySettings - Query settings for the download.

o DatabaseFormatOptions - Data/time format options.

o DatabaseUserLibraryList - A list of libraries to use with the request.

| want an . © 2007 IBM Corporation



IBM System i

Data Transfer ActiveX Automation Objects

DatabaseDownloadRequest Object Methods

The DatabaseDownloadRequest object has several methods to perform various
tasks:

o« Download - Run the configured download

e DownloadAsync - Runs the configured download asynchronously
e LoadRequest - Used to load a stored download request

e SaveRequest - Used to save the current request

e Cancel - Cancels a running Async request
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Data Transfer ActiveX Automation Objects

A simple Visual Basic program to run a download using the low level
DatabaseDownloadRequest object:

Dim dIr As New cwbx.DatabaseDownloadRequest
Dim mySystem As New cwbx.AS400System

mySystem.Define “MySystemName"
mySystem.UserID = “MyUserID"
mySystem.Password = “MyPassword"

Set dIr.System = mySystem
dir.AS400File = “QIWS/QCUSTCDT"
dir.pcFile = "c:\mycustomers.x|s"
dir.pcFile.FileType = cwbdtBIFF8

dir.Download
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Data Transfer ActiveX Automation Objects

Using the DatabaseUploadRequest Object

The DatabaseUploadRequest object can be used to programmatically perform an

upload to the System i5 from a PC workstation. It contains 3 additional objects that
may be set to perform an upload:

o DatabaseAS400File - Stores the name of the file or files to download.

o DatabaseUploadPCFile - Stores the name of the PC file to upload, plus file
options.

o DatabaseUserLibraryList - A list of libraries to use with the request.
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Data Transfer ActiveX Automation Objects

DatabaseUploadRequest Object Methods

The DatabaseDownloadRequest object has several methods to perform various tasks:
e Upload - Run the configured upload
e UploadAsync - Runs the configured upload asynchronously
o LoadRequest - Used to load a stored upload request
o SaveRequest - Used to save the current upload request
e Cancel - Cancels a running Async request
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Data Transfer ActiveX Automation Objects

Asynchronous Methods

The DatabaseDownloadRequest and DatabaseUploadRequest objects have
asynchronous capabilities. This means the upload or download request can run "In

the background" while program execution continues. A running Async request may
also be cancelled by the main program.

The UploadAsync and DownloadAsync methods also pass events back to the
running program. These events are:

o StatusChanged - Indicates that something has changed, like the request has

completed, or there was an error, or a specific number of rows has been
transferred.

o UploadComplete - Indicates that an upload completed
o DownloadComplete - Indicates that a download completed
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More information

Additional Information on the iSeries Access for Windows ActiveX automation objects can
be found in the iSeries Access for Windows Toolkit.

This information can be found under the ActiveX section of the Database portion of the
Toolkit documentation.

| want an . © 2007 IBM Corporation



IBM System i

Sample Code Disclaimer

This material contains IBM copyrighted sample programming source code for your
consideration. This sample code has not been thoroughly tested under all conditions.
IBM, therefore, cannot guarantee or imply reliability, serviceability, or function. IBM
provides no program services for this material. This material is provided "AS 1S"
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING,
BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF FITNESS FOR A
PARTICULAR PURPOSE, OR NON-INFRINGEMENT. SOME JURISDICTIONS DO
NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES, SO THE ABOVE
EXCLUSIONS MAY NOT APPLY TO YOU. IN NO EVENT WILL IBM BE LIABLE TO
ANY PARTY FOR ANY DIRECT, INDIRECT, SPECIAL OR OTHER CONSEQUENTIAL
DAMAGES FOR ANY USE OF THIS MATERIAL INCLUDING, WITHOUT LIMITATION,
ANY LOST PROFITS, BUSINESS INTERRUPTION, LOSS OF PROGRAMS OR
OTHER DATA ON YOUR INFORMATION HANDLING SYSTEM OR OTHERWISE,
EVEN IF EXPRESSLY ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.
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Trademarks and Disclaimers

© IBM Corporation 1994-2007. All rights reserved.
References in this document to IBM products or services do not imply that IBM intends to make them available in every country.

Trademarks of International Business Machines Corporation in the United States, other countries, or both can be found on the World Wide Web at
http://www.ibm.com/legal/copytrade.shtml.

Intel, Intel logo, Intel Inside, Intel Inside logo, Intel Centrino, Intel Centrino logo, Celeron, Intel Xeon, Intel SpeedStep, Itanium, and Pentium are trademarks or registered
trademarks of Intel Corporation or its subsidiaries in the United States and other countries.

Linux is a registered trademark of Linus Torvalds in the United States, other countries, or both.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft Corporation in the United States, other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and other countries.

Java and all Java-based trademarks are trademarks of Sun Microsystems, Inc. in the United States, other countries, or both.

Other company, product, or service names may be trademarks or service marks of others.

Information is provided "AS IS" without warranty of any kind.

The customer examples described are presented as illustrations of how those customers have used IBM products and the results they may have achieved. Actual
environmental costs and performance characteristics may vary by customer.

Information concerning non-IBM products was obtained from a supplier of these products, published announcement material, or other publicly available sources and
does not constitute an endorsement of such products by IBM. Sources for non-IBM list prices and performance numbers are taken from publicly available information,
including vendor announcements and vendor worldwide homepages. IBM has not tested these products and cannot confirm the accuracy of performance, capability, or
any other claims related to non-IBM products. Questions on the capability of non-IBM products should be addressed to the supplier of those products.

All statements regarding IBM future direction and intent are subject to change or withdrawal without notice, and represent goals and objectives only.

Some information addresses anticipated future capabilities. Such information is not intended as a definitive statement of a commitment to specific levels of performance,
function or delivery schedules with respect to any future products. Such commitments are only made in IBM product announcements. The information is presented here
to communicate IBM's current investment and development activities as a good faith effort to help with our customers' future planning.

Performance is based on measurements and projections using standard IBM benchmarks in a controlled environment. The actual throughput or performance that any
user will experience will vary depending upon considerations such as the amount of multiprogramming in the user's job stream, the 1/O configuration, the storage
configuration, and the workload processed. Therefore, no assurance can be given that an individual user will achieve throughput or performance improvements
equivalent to the ratios stated here.

Photographs shown may be engineering prototypes. Changes may be incorporated in production models.
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